Unicenter® Service Desk

ITIL User Guide

r11.2
This documentation (the "Documentation") and related computer software program (the "Software") (hereinafter collectively referred to as the "Product") is for the end user’s informational purposes only and is subject to change or withdrawal by CA at any time.

This Product may not be copied, transferred, reproduced, disclosed, modified or duplicated, in whole or in part, without the prior written consent of CA. This Product is confidential and proprietary information of CA and protected by the copyright laws of the United States and international treaties.

Notwithstanding the foregoing, licensed users may print a reasonable number of copies of the Documentation for their own internal use, and may make one copy of the Software as reasonably required for back-up and disaster recovery purposes, provided that all CA copyright notices and legends are affixed to each reproduced copy. Only authorized employees, consultants, or agents of the user who are bound by the provisions of the license for the Software are permitted to have access to such copies.

The right to print copies of the Documentation and to make a copy of the Software is limited to the period during which the license for the Product remains in full force and effect. Should the license terminate for any reason, it shall be the user’s responsibility to certify in writing to CA that all copies and partial copies of the Product have been returned to CA or destroyed.

EXCEPT AS OTHERWISE STATED IN THE APPLICABLE LICENSE AGREEMENT, TO THE EXTENT PERMITTED BY APPLICABLE LAW, CA PROVIDES THIS PRODUCT "AS IS" WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NONINFRINGEMENT. IN NO EVENT WILL CA BE LIABLE TO THE END USER OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT, FROM THE USE OF THIS PRODUCT, INCLUDING WITHOUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF CA IS EXPRESSLY ADVISED OF SUCH LOSS OR DAMAGE.

The use of this Product and any product referenced in the Documentation is governed by the end user's applicable license agreement.

The manufacturer of this Product is CA.

This Product is provided with "Restricted Rights." Use, duplication or disclosure by the United States Government is subject to the restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7013(c)(1)(ii), as applicable, or their successors.

All trademarks, trade names, service marks, and logos referenced herein belong to their respective companies.

Copyright © 2005 CA. All rights reserved.
CA Product References

This document references the following CA products:

- Advantage™
- Allfusion®
- BrightStor®
- CleverPath™ Portal
- eTrust® Embedded Identity and Access Management (eTrust eIAM)
- Unicenter® Asset Management
- Unicenter® Asset Portfolio Management (APM)
- Unicenter® Management Portal
- Unicenter® Network and Systems Management (NSM)
- Unicenter® Remote Control
- Unicenter® Service Desk
- Unicenter® Knowledge Tools (KT)
- Unicenter® Software Delivery
- Unicenter® TNG for Windows

Contact Technical Support

For online technical assistance and a complete list of locations, primary service hours, and telephone numbers, contact Technical Support at http://ca.com/support.
Contents

Chapter 1: Introduction ................................................................. 7
Audience ................................................................................. 7
What You Need to Know ....................................................... 7

Chapter 2: Overview of Information Technology Infrastructure Library (ITIL) ......................................................... 9
ITIL Service Support .................................................................. 9
  Incident Management ......................................................... 9
  Problem Management ....................................................... 10
  Change Management .......................................................... 10
  Configuration Management .................................................. 11
ITIL Service Delivery .............................................................. 11
  Service Level Management ............................................... 12
Sample ITIL Process Flow Diagram ......................................... 13

Chapter 3: Incident Management ............................................... 15
Main Page .............................................................................. 15
Work with Incidents ............................................................... 16
Incident Search Page ............................................................. 24
  Reports ............................................................................. 25

Chapter 4: Request Management ............................................... 27
Functionality .......................................................................... 27

Chapter 5: Problem Management ............................................. 33
Main Page .............................................................................. 33
Work with Problems ............................................................. 34
Problem Search Page ............................................................ 39
  Reports ............................................................................. 40

Chapter 6: Change Management .............................................. 41
Main Page .............................................................................. 41
Work with Change Orders ...................................................... 42
Change Order Search Page .................................................. 44
  Reports ............................................................................. 46
Chapter 1: Introduction

Welcome to Unicenter Service Desk, the most advanced tool for delivering superior user support services in heterogeneous UNIX and Windows computing environments. This product is a comprehensive, integrated solution for the total automation and management of both external (customer support) and internal (enterprise service center management) service desks.

Audience

This guide is intended for anyone who will use Unicenter Service Desk as an analyst or administrator. The purpose of this guide is to help analysts and administrators start using Unicenter Service Desk in accordance with the applicable aspects of the Information Technology Infrastructure Library (ITIL) best practice processes for Service Support and Service Delivery. This guide will benefit anyone who wants to understand how Unicenter Service Desk solves the challenge of automating and managing service support, including Incident Management, Problem Management, Change Management, Configuration Management, and Service Level Management.

What You Need to Know

To follow the instructions in this guide, you need a working knowledge of the operating system and Windows environment for your installation. This guide assumes you or someone in your organization has already gone through the necessary steps to install and configure the product, according to the information in the Implementation Guide.
Chapter 2: Overview of Information Technology Infrastructure Library (ITIL)

This chapter provides an overview of ITIL and its components.

**ITIL Service Support**

The following sections discuss the components of ITIL’s Service Support: Incident Management, Problem Management, Change Management, and Configuration Management. Only the components specifically addressed by Unicenter Service Desk are covered.

**Incident Management**

The main responsibilities of Incident Management are:

- Incident detection and recording
- Classification of incidents and initial support
- Resolution and recovery
- Incident closure
- Incident ownership and tracking

Unicenter Service Desk supports these processes, enabling incidents to be recorded, classified, escalated, and tracked. To assist with resolution, it provides integrated access to knowledge based tools and known errors, and permits integrated access to diagnostic tools, such as Unicenter Asset Management, Unicenter Remote Control, Unicenter Network and Systems Management, as well as Unicenter Asset Portfolio Management for contracts and licenses for accurate service information or financial details.
Problem Management

The main responsibilities of Problem Management are:
- Problem identification and recording
- Problem classification
- Problem investigation and diagnosis
- Proactive prevention of problems using techniques, such as trend analysis
- Problem reviews
- Management reports on problem causes

Unicenter Service Desk provides the means to record and classify problems. It provides the integrated hand over of incidents to the problem management process. It also provides the facilities to enable the tracking and escalating of problems through to resolution, and generating known errors when the resolution is identified. It permits integrated access to diagnostic tools, such as Unicenter Asset Management, Unicenter Remote Control, Unicenter Network and Systems Management, as well as Unicenter Asset Portfolio Management for contracts and licenses for accurate service information or financial details. It also provides the management reporting required.

Change Management

The main responsibilities of Change Management are:
- Raising and recording change requests
- Assessing the impact, cost, benefit and risk of a change
- Obtaining proper approval for changes
- Managing the implementation of the change
- Monitoring and reporting on the implementation
- Reviewing and closing change requests

Unicenter Service Desk provides the means to record and track change requests. These can be entered directly or flow from incidents or problems. Unicenter Service Desk also supports the approvals process, enabling the change procedures to be tracked and accounted.
Configuration Management

The main responsibilities of Configuration Management are:

- Identify all relevant configuration items
- Maintain control over the configuration items
- Account for the status of the configuration items
- Provide audit information on the configuration items
- Enable planning

Unicenter Service Desk contains information about the configuration items being managed in its repository, allowing them to be used in the other ITIL processes. It permits integrated access to diagnostic tools, such as Unicenter Asset Management, Unicenter Remote Control, Unicenter Network and Systems Management, as well as Unicenter Asset Portfolio Management for contracts and licenses for accurate service information or financial details. It also provides the management reporting required.

ITIL Service Delivery

The following section discusses the Service Level Management component of ITIL's Service Delivery. Only the component specifically addressed by Unicenter Service Desk is covered.
Service Level Management

The main responsibilities of Service Level Management are:

- Negotiating and agreeing upon service deliverable targets
- Measuring and reporting on the service levels achieved, resources required, and cost
- Continuously improving service levels
- Coordinating other Service Management functions
- Reviewing SLAs to meet changing business needs

Unicenter Service Desk enables the recording of negotiated SLAs for the delivery of service by the service desk organization to its customers. It allows for reporting on progress against the SLA, while proactive warnings can be generated when there is a risk of not achieving the SLA. This is performed through the use of the new built-in Service Entitlement, as well as the Time to Violation processing. In general, Service Entitlement enhances Unicenter Service Desk's SLA functionality by helping large call centers define the service levels for their multiple organizations. It allows for every organization to be assigned to a single contract and every contract to be assigned an organization, thereby centralizing the management of Service Types. In addition, an association can be mapped to specific service types. The Time to Violation flag (fired by events) triggers if the status of a ticket does not change, which is updated with every update.
The following diagram shows a sample flow that can be used in Unicenter Service Desk to support ITIL processes.
Chapter 3: Incident Management

To support the Incident Management processes of ITIL, Unicenter Service Desk was modified to use ITIL-specific terminology and processes. This chapter provides a brief overview of the functionality provided in Unicenter Service Desk, r11.

Main Page

Once logged in to the web interface of Unicenter Service Desk, the following form appears:

At this point, you are able to view all available announcements. Additionally, by going to the top right corner of the page, you can enter an Incident number assigned to any existing Incident and by clicking Go, navigate directly to your selected Incident’s Detail window. Also included on the main page is the Scoreboard, where default nodes have been subdivided into folders that can assist all users in quickly identifying elements of interest.
Work with Incidents

To create new incidents, you must select the File menu and choose New Incident or New Incident from Template, as shown in the following example:

Another option available for your use is Profile Browser, which you can access from the View menu, as shown in the following example:
By selecting Profile Browser, the following Contact Information for Heldman, John Q appears which provides you with a launch point for creating new Incidents after first viewing your customer’s details. Any information previously entered into the Scratchpad field automatically transfers to the Incident’s description field.
The next example shows the Incident Detail form and the options available on the Activities menu. These options provide easy handling of activities that are regularly conducted during the life of an Incident. For example, you can select Update Status to set a new status for the Incident, such as Closed from Open. This functionality also provides you with the opportunity to enter descriptive information as to why the Incident is being set to this new status.

By using the Incident Area field on the Incident Detail form, you can categorize the Incident for ease of reporting, as well as provide automated assignment and escalation functionality. For a full description of these elements, see Request Area Setup and Automatic Assignment in the chapter "Establish the Support Structure" of the Unicenter Service Desk Administrator Guide.
On the Incident Detail form, the two key fields that are specific to the ITIL configuration are: Incident Priority and Problem. For example, the Incident Priority field illustrated by the following example reflects a sum of 6:
The Incident Priority field is calculated by taking the sum of two integer fields (called Value) that have been added to the Impact and Urgency tables. The Value field displays on the following Impact Detail and Urgency Detail forms, which are accessed from the Administration tab:
Using the default values, the Incident Priority value can fall within the following range:

- 0 (where Urgency = none and Impact = none) to
- 10 (where Urgency = 5 and Impact = 5)

However, the administrator can change the values to implement a different Incident Priority scheme. Using the previous Impact and Urgency Detail forms as examples, suppose the administrator changes the Urgency from 2 to a value of 20, and the Impact from 4 to a value of 40:
Work with Incidents

This would result in an Incident Priority of 60 for new Incidents, even though Urgency 2 and Impact of 4 currently appear on the Incident Detail form:
Existing Incidents remain unaffected until either the Urgency or Impact value is changed, but if either value is changed, the Incident Priority is recomputed when the ticket is saved.

**Note:** The Incident Priority field is separate from the Priority field and cannot be manually set. The Problem field can be manually set from the Incident Detail form (while in edit mode), as well as from the Problem Detail form.

Additionally, a Create Problem button (top, right of the form) has been added to Incident Detail for the ITIL configuration. This button lets you create a new Problem containing information from the following fields in the originating Incident:

- Affected End User
- Assignee
- Group
- Priority
- Severity
- Urgency
- Impact
- Change
- Configuration Item
- Summary
- Description
Incident Search Page

To assist in locating Incidents, the Scoreboard and the Incident Search form are very useful tools. The Scoreboard provides the following default nodes that should be useful in supporting the Incident Management processes.

Following are the default nodes under “My Queue”:

**My Incidents**

This node displays all active Incidents that have been assigned to the logged in user.

**Today’s Inc Callbacks**

This node displays all active Incidents that are assigned to the logged in user and have the call back flag set to call back today or earlier.

Following are the default nodes under “Incidents” > “Assigned”:

**All**

This node displays all assigned Incidents, regardless of priority.

**High Priority**

This node displays all priority 1 Incidents that have an assignee or an assigned group.

**Medium Priority**

This node displays all priority 2 or priority 3 Incidents that have an assignee or an assigned group.

**Low Priority**

This node displays all priority 4, priority 5, or priority None Incidents that have an assignee or an assigned group.

Following are the default nodes under “Incidents” > “Unassigned”:

**All**

This node displays all unassigned Incidents, regardless of priority.

**High Priority**

This node displays all priority 1 Incidents that do not have an assignee or an assigned group.

**Medium Priority**

This node displays all priority 2 or priority 3 Incidents that do not have an assignee or an assigned group.

**Low Priority**

This node displays all priority 4, priority 5, or priority None Incidents that do not have an assignee or an assigned group.
The Incident Search form is available by selecting Incidents from the Search menu located on the menu bar. As you can see from the following example, the Incident Search form provides you with several options for editing an incident, specifically, the Edit in List button, as well as many fields for performing a granular search. The selection of available fields can be expanded by clicking on the green filter icons located on the right side of the Incident Search form.

### Reports

Both the Incident Detail form and the Incident Search form provide the means for you to retrieve a detail or summary report by selecting Summary or Detail from the Reports menu. If your selection is from the Incident Search form, information for all displayed incidents is provided in the reports.

When Unicenter Service Desk is configured to use the ITIL methodology, you can also easily retrieve reports for Incidents and Problems. Both Incidents and Problems are held in the Call_Req table along with Requests. The **Type** column distinguishes the record as follows:

- **R** = Request
- **I** = Incident
- **P** = Problem

You can modify existing out-of-the-box reports by adding the type field and the appropriate value to the where clause of the SQL query.

**Note:** If the Incident is attached to a Problem, a pointer to the Problem is stored in the problem field of the Incident. Also for Incidents, the Incident Priority value is stored in the incident_priority field.
Chapter 4: Request Management

Request Management is part of the base Unicenter Service Desk functionality and can be used as part of a cohesive solution for delivering the standard customer support processes. This integrated functionality can be used in concert with both ITIL Incident Management and Problem Management as dictated by the processes used in your organization.

**Functionality**

In general, this functionality can be used to support Requests directed to Support or questions from customers in your organization. Therefore, the differentiation between Service Requests and Incidents are defined as follows:

**Service Requests**

These could be described as a request from a user for support, information, or assistance and does not represent a failure in the IT infrastructure.

**Incidents**

These could be described as any event that causes a reduction in the quality of the service of your IT infrastructure.
Functionality

Depending on the style and structure of your support organization, having this extra ability to categorize activity at the service desk can be quite valuable.

Additionally, because of the way this functionality is delivered, certain advantages are available. Because Incidents, Problems, and Requests are all stored in the same table, you can easily report on all Problems, Incidents, and Requests by a specific customer, end-user, or their organization.

The following example represents this Request Search form:

By default, the employee interface permits users to create Requests instead of Incidents. If you decide to use Incidents exclusively, you can change this behavior by simply creating a Data Partition with a Defaults Constraint that always creates Incidents instead of Requests, and then assigning this Data Partition to your end-users.
Use the following **Create New Data Partition Constraint** form to create the new Data Partition with a Default Constraint:

![Create New Data Partition Constraint form](image)

**Note:** For more information on the steps required, see Establish Data Partitions in the chapter “Policy Implementation” of the *Unicenter Service Desk Administrator Guide*.

The following example of the Data Partition Constraint Detail form displays a specific Data Constraint (with type = 'I').

**Note:** When using the Data Constraint type=I, be sure to capitalize the I because it is case-sensitive.
In this example, a sample Data Partition named Employee has already been created.
At this point, the administrator needs to customize the terminology on the Employee Web Interface so that the term Incident displays instead of the term Request. Otherwise, the customer sees Request and refers to Requests, causing confusion for the analyst who sees them as Incidents. An administrator can use the following Personalized Response Detail form to customize certain fields for certain types of tickets; specifically, Incidents and Problems. This particular form is not exclusive to ITIL, but displays for certain types of tickets if designated to do so.
Chapter 5: Problem Management

To support the Problem Management processes of ITIL, Unicenter Service Desk was modified to use ITIL specific terminology and processes. This chapter provides a brief overview of the functionality provided in Unicenter Service Desk, r11.

Main Page

Once logged in to the web interface of Unicenter Service Desk, the following form appears. In this example, the Problems node has been selected to display the Assigned problems:

From this point, you are able to view all available announcements. Additionally, by going to the top right corner of the page, you can choose Problem from the drop-down menu, and then enter a number assigned to any existing Problem. By clicking Go, you can navigate directly to your selected Problem’s Detail window. Also included on the main page is the Scoreboard, where default nodes have been subdivided into folders that can assist all users in quickly identifying elements of interest.
To begin working with problems, select the File menu and choose New Problem or New Problem from Template, as illustrated by the following example:

The next example shows the Problem Detail form and the options available on the Activities menu. These options provide easy handling of activities that are regularly conducted during the life of a Problem. For example, you can select Update Status to set a new status for the Problem, such as Closed from Open. This functionality also provides you with the opportunity to enter descriptive information as to why the Problem is being set to this new status.
By using the Problem Area field on the Problem Detail form, you can categorize the Problem for ease of reporting, as well as provide automated assignment and escalation functionality. For a full description of these elements, see Request Area Setup and Automatic Assignment in the chapter "Establish the Support Structure" of the Unicenter Service Desk Administrator Guide.

On the Problem Detail form, the key element that is specific to the ITIL configuration is the Attached Incidents tab located in the lower portion of the form. From this notebook tab, you can attach and remove Incidents. Simply click Attach/Remove Incidents and follow the prompts to accomplish these steps.
The following Request/Incident/Problem Area Detail form contains values that can be customized so that certain fields display for certain types of tickets (Requests, Incidents, and Problems). It contains check boxes that control when the form is presented to the user. The administrator sets these values by accessing the Administration tab. Results display on the following example form:
Another form that contains values that can be customized so that certain fields display for certain types of tickets is the following Request/Incident/Problem Status Detail form. It now offers a new status called Known Error (which displays in the Symbol field), that applies to Problems only. This new status is one of the methods available for implementing the known errors part of ITIL Problem Management.

Note: Another method available for implementing known errors of ITIL Problem Management is to use Unicenter Knowledge Tools.
Finally, the following Personalized Response Detail form can be customized by the administrator so that certain fields display for certain types of tickets; specifically, Incidents and Problems. As previously mentioned, this particular form is not exclusive to ITIL, but displays for certain types of tickets if designated to do so.
To assist in locating problems, the Scoreboard and the Problem Search form are very useful tools. The Scoreboard is provided with the following default nodes that should be useful in supporting the Problem Management processes.

Following are the default nodes under “My Queue”:

**My Problems**
This node displays all active problems that have been assigned to the logged in user.

**Today’s Prb Callbacks**
This node displays all active problems that are assigned to the logged in user and have the call back flag to call back today or earlier.

Following are the default nodes under “Problems” > “Assigned”:

**All**
This node displays all assigned Problems, regardless of priority.

**High Priority**
This node displays all priority 1 problems that have an assignee or an assigned group.

**Medium Priority**
This node displays all priority 2 or priority 3 problems that have an assignee or an assigned group.

**Low Priority**
This node displays all priority 4, priority 5, or priority None problems that have an assignee or an assigned group.

Following are the default nodes under “Problems” > “Unassigned”:

**All**
This node displays all unassigned Problems, regardless of priority.

**High Priority**
This node displays all priority 1 problems that do not have an assignee or an assigned group.

**Medium Priority**
This node displays all priority 2 or priority 3 problems that do not have an assignee or an assigned group.

**Low Priority**
This node displays all priority 4, priority 5, or priority None problems that do not have an assignee or an assigned group.
The Problem Search form is available by selecting Problems from the Search menu located on the menu bar. As you can see from the following example, the Problem Search form provides you with many fields for performing a granular search. The selection of available fields can be expanded by clicking on the green filter icons located on the right side of the Search form.

Reports

Both the Problem Detail form and the Problem Search form provide the means for you to retrieve a detail or summary report by selecting Summary or Detail from the Reports menu. If your selection is from the Problem Search form, information for all displayed problems is provided in the reports.

When Unicenter Service Desk is configured to use the ITIL methodology, you can also easily retrieve reports for Incidents and Problems. Both Incidents and Problems are held in the Call_Req table along with Requests. The Type column distinguishes the record as follows:

- R = Request
- I = Incident
- P = Problem

You can modify existing out-of-the-box reports by adding the type field and the appropriate value to the where clause of the SQL query.

Note: If the Incident is attached to a Problem, a pointer to the Problem is stored in the problem field of the Incident. Also for Incidents, the Incident Priority value is stored in the incident_priority field.
Chapter 6: Change Management

To support the Change Management processes of ITIL, Unicenter Service Desk was modified to use ITIL specific terminology and processes. This chapter provides a brief overview of the functionality provided in Unicenter Service Desk, r11.

Main Page

Once logged in to the web interface of Unicenter Service Desk, the following form appears:

From this point you are able to view all available announcements. Additionally, by going to the top right corner of the page, you can choose Change from the drop-down menu, and then enter the number assigned to any existing Change. By clicking Go, you can navigate directly to your selected Change's Detail window.

Also included on the main page is the Scoreboard, where default nodes have been subdivided into folders that can assist all users in quickly identifying elements of interest.
Work with Change Orders

To create new change orders, you must select the File menu and choose New Change Order or New Change Order from Template, as illustrated by the following example:
The next example shows the Change Detail form and the options available on the Activities menu. These options provide easy handling of activities that are regularly conducted during the life of a Change. For example, you can select Update Status to set a new status for the Change, such as Closed from Open. This functionality also provides you with the opportunity to enter descriptive information as to why the Change is being set to this new status.

By using the Category field on the Change Detail form, you can categorize the Change for ease of reporting, as well as provide automated assignment and escalation functionality. For a full description of these elements, see Request Area Setup and Automatic Assignment in the chapter "Establish the Support Structure" of the Unicenter Service Desk Administrator Guide.

To support the RFC functionality of ITIL, a status of RFC (Request For Change) has been added to the default list of statuses provided with Unicenter Service Desk. RFC is the default for new Change Orders, which is set in $NX_ROOT\bopcfg\majic\itil.mod.

On the Change Detail form, the key element that is specific to the ITIL configuration is the Incidents/Problems tab. From this notebook tab, you can attach Incidents, Problems, and Requests. Simply click the appropriate button to Attach Incidents, Attach Problems, or Attach Requests, and follow the prompts to accomplish these steps. Once attached, you can remove an Incident, Problem, or Request by opening the item and removing it from there.
Change Order Search Page

To assist in locating changes, the Scoreboard and the Change Order Search form are very useful tools. The Scoreboard is provided with the following default nodes that should be useful in supporting the Change Management processes.

Following are the default nodes under "My Queue":

My Change Orders
This node displays all active changes that have been assigned to the logged in user.

Today's CO Callbacks
This node displays all active changes that are assigned to the logged in user and have the call back flag set to today or earlier.

Following are the default nodes under "Change Orders" > "Assigned":

All
This node displays all changes that have an assignee or an assigned group.

Priority 1
This node displays all priority 1 changes that have an assignee or an assigned group.

Priority 2
This node displays all priority 2 changes that have an assignee or an assigned group.

Priority 3
This node displays all priority 3 changes that have an assignee or an assigned group.

Priority 4
This node displays all priority 4 changes that have an assignee or an assigned group.

Priority 5
This node displays all priority 5 changes that have an assignee or an assigned group.

Priority None
This node displays all priority None changes that have an assignee or an assigned group.
Following are the default nodes under “Change Orders” > “Unassigned”:

**All**
This node displays all changes that do not have an assignee or an assigned group.

**Priority 1**
This node displays all priority 1 changes that do not have an assignee or an assigned group.

**Priority 2**
This node displays all priority 2 changes that do not have an assignee or an assigned group.

**Priority 3**
This node displays all priority 3 changes that do not have an assignee or an assigned group.

**Priority 4**
This node displays all priority 4 changes that do not have an assignee or an assigned group.

**Priority 5**
This node displays all priority 5 changes that do not have an assignee or an assigned group.

**Priority None**
This node displays all priority None changes that do not have an assignee or an assigned group.
The Change Order Search form is available by selecting Change Orders from the Search menu located on the menu bar. As you can see from the following example, the Change Order Search form provides you with several options for editing the change, specifically, the Edit in List button, as well as many fields for performing a granular search. The selection of available fields can be expanded by clicking on the green filter icons located on the right side of the Search form.

From the Change Order Detail form and Change Search form, you are able to select either a detail or summary report by selecting Summary or Detail from the Reports menu. In the case of the Change Order Search form, information on all displayed changes would be provided in the reports.
Chapter 7: Configuration Management

To support the Configuration Management processes of ITIL, Unicenter Service Desk was modified to use ITIL specific terminology and processes. This chapter provides a brief overview of the functionality provided in Unicenter Service Desk, r11.

Main Page

Once logged in to the web interface of Unicenter Service Desk, the following form appears:

From this point, you are able to view all available announcements.
To create a new Configuration item, select the File menu and choose New Configuration Item, as shown by the following example:

The next example shows the "Server A" Configuration Item Detail form. On this form, the key elements that are specific to the ITIL configuration are the Incidents and Problems tabs, as well as additional fields on the Log tab.
To assist in locating Configuration Items, the Scoreboard and the Configuration Items Search form are very useful tools. The Scoreboard is provided with the following default nodes that should be useful in supporting the Configuration Management processes.

Following are the default nodes under "Configuration Items" > Active:

**My High Priority**
This node displays all Configuration Items that are active, have a priority of 1, and the logged in user is the assigned "primary contact".

**My Medium Priority**
This node displays all Configuration Items that are active, have a priority of 2 or 3, and the logged in user is the assigned "primary contact".

**My Low Priority**
This node displays all Configuration Items that are active, have a priority of 4, 5, or None, and the logged in user is the assigned "primary contact".

**Off Warranty**
This node displays all active Configuration Items that have a Warranty End Date that equals today or earlier.

**Expired**
This node displays all active Configuration Items that have an Expiration Date that equals today or earlier.

**Owned by my Org**
This node displays all active Configuration Items that have a Responsible Organization that is the same as the logged in user's organization.

**Maintained by my Org**
This node displays all active Configuration Items that have a Maintenance Organization that is the same as the logged in user's organization.

Following are the default nodes under "Configuration Items" > "Inactive":

**My High Priority**
This node displays all Configuration Items that are inactive, have a priority of 1, and the logged in user is the assigned "primary contact".

**My Medium Priority**
This node displays all Configuration Items that are inactive, have a priority of 2 or 3, and the logged in user is the assigned "primary contact".
My Low Priority
This node displays all Configuration Items that are inactive, have a priority of 4, 5, or None, and the logged in user is the assigned "primary contact".

Off Warranty
This node displays all inactive Configuration Items that have a Warranty End Date that equals today or earlier.

Expired
This node displays all inactive Configuration Items that have an Expiration Date that equals today or earlier.

Owned by my Org
This node displays all inactive Configuration Items that have a Responsible Organization that is the same as the logged in user's organization.

Maintained by my Org
This node displays all inactive Configuration Items that have a Maintenance Organization that is the same as the logged in user's organization.

The following is an example of the Configuration Item Search form:

The Configuration Item Search form is available by selecting Configuration Items under the Search menu of the menu bar. As you can see from the previous example, you are provided with many fields for performing a very granular search. This selection of available fields can be expanded by clicking on the green filter icons located on the right side of the Search form.
The following is an example of the Configuration Item List form that displays the results of a search. From this form, you can access detailed information by clicking a particular item:

**Reports**

From the Configuration Item Detail form and Configuration Item Search form, you are able to select either a detail or summary report by selecting Summary or Detail under the Reports menu. In the case of the Configuration Item Search form, information on all displayed Configuration Items would be provided in the reports.
Chapter 8: Service Level Management

Service Level Management is supported through the following features of Unicenter Service Desk:

- Service Types (including SLA Violation and Escalation functionality)
- Functionality associated with Incident Area and Problem Area
- Call Back Flag functionality
- Auto Assignment
- Scoreboard
- Reporting
- Automated Notification

These features are predominantly items that are configured by an administrator and as such, are all fully described in the Unicenter Service Desk Administrator Guide.
Index

A
accessing
  the change order search form • 44
  the configuration item search form • 49
  the incident search form • 24
  the problem search form • 39
activities menu • 16, 34, 42
announcements • 15, 33, 41, 47
Attached Incidents tab • 34

B
buttons
  create incident • 34
  create problem • 16
  edit in list • 24, 39, 44

C
Change Detail window • 41
change management
  available reports • 46
  Change Detail form • 42
  definition of • 10
  Incidents/Problems tab • 42
  working with • 42
changes
  locating • 44
    search form • 44
Configuration Item Search form • 49
collection of • 9
data constraint • 27
diagram, about the ITIL
  sample process flow • 13
dialogs
  Contact Information for Analyst, ITIL • 16
  Data Partition Constraint Detail • 27

E
edit in list button • 24, 39, 44

F
fields
  priority • 16
  problem • 16
forms
  Change Detail • 42
  Change Order Search • 44
  Configuration Item Search • 49
  Incident Detail • 16
  Incident Search • 24
  Problem Detail • 34
  Problem Search • 39
  Server Configuration Item Detail • 48

I
Incident Detail form • 16
incident management
  definition of • 9
  working with • 16
incident priority field • 16
incidents
  attaching and removing • 34
  available reports • 25, 40
  Detail window • 15
  Incident Detail form • 16
  locating • 24
  profile browser option • 16
  Search form • 24
  using the Scoreboard • 24
  working with • 16
incidents/problems tab • 42, 48
ITIL
  overview • 9
  problem management • 33
  sample process flow diagram • 13

L
locating
  changes • 44
  configuration items • 49

M
main window for Unicenter Service Desk • 15, 33, 41, 47
management
  change • 10
  configuration • 11
  incident • 9
  problem • 10
  service level • 12

P
Problem Detail window • 33
problem field • 16
problem management
  accessing • 33
  attached incidents tab • 34
  definition of • 10
  overview • 33
  Problem Detail form • 34
  working with • 34
problems
  locating • 39
  using the Scoreboard • 39
process flow, for ITIL • 13
profile browser option • 16

R
request management
  functionality • 27
  overview • 27

S
scoreboard default nodes • 24, 39, 44, 49
service delivery disciplines
  service level management • 12
service level management
  overview • 12
  supported features • 53
service support disciplines
  change management • 10
  configuration management • 11
  incident management • 9
  problem management • 10

T
Tabs
  attached incidents • 34
  incidents/problems • 42, 48

U
Unicenter Service Desk main window • 15, 33, 41, 47

W
windows
  Change Detail • 41
  Incident Detail • 15
  Problem Detail • 33
working with
  change management • 42
  configuration management • 48
  incidents • 16, 34

56 ITIL User Guide